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Perspective Installation Guide System Requirements

SYSTEM REQUIREMENTS

The following requirements are for Perspective operating in a traditional LAN/WAN environment with the Web server component
running on a separate Microsoft® IIS box. These specs are for planning purposes only and apply to Perspective™ V.5.3.1.1,
Dispatch, and Connect. Please contact your Resolver representative for a specific assessment of your needs.

NOTE: Meeting the Minimum system requirements means you can run the application successfully, but it may not provide the best
performance. Meeting the Recommended requirements will offer a significantly better experience.

MINIMUM
Processor Speed 2 GHz dual-core 2.5 GHz dual-core
Memory 2GB 4 GB
Operating System Windows® 7 SP 1, Windows® 8.1, Windows® 10
.NET Framework Version 4.5.2

LG T T Internet Explorer® 11, Edge

Perspective

\F/,\(/)itt;lBrowser— Web Internet Explorer® 11, Edge, Google Chrome®, Safari® iOS 9+, Android® Browser 4.2+
Web Browser — Connect Google Chrome®

Third Party Application Adobe Reader®9.4.0+, Sun Java® Runtime Environment 7 U71, 8 U251
Mobile i0S App i0S 9,i0S 10

Officer Mobile i0S 9, i0S 10, Android 4.4, Android 5.1, Android 6.0

Available Disk Space* 1GB 2GB

Processor Speed 2 GHz dual-core 2.5 GHz quad-core

Memory 8 GB 16 GB

i Windows Server® 2012, Windows Server® 2012 R22, Windows Server® 2016,
Operating System 5
1IS with WebSockets enabled® and Secure-Channel configured (HTTPS/SSL)

.NET Framework Version 4.5 with HTTP and non-HTTP activation, .NET Core 1.0.4 or 1.1.1 (Windows Hosting)?
C++ Runtime Libraries C++ 2010 SP1 Runtime Libraries (x64) 10.40219

Message Queue2 RabbitMQ Server 3.6.9+

DATABASE SERVER MACHINE3 (ON PREMISE ONLY)

Available Disk Space 2 GB 20+ GB

Processor Speed 2 GHz dual-core 64-bit server dual-core or multi-processors
Memory 2GB 4+ GB
Database Server® SQL Server® 2012 SP3, SQL Server® 2014 SP2, SQL Server® 2016 SP1

Reporting Services SQL Server® 2012 Reporting Services, SQL Server® 2014 Reporting Services, SQL Server® 2016 Reporting Services

This requirement only applies if using Visual Analysis.

This requirement only applies to Connect.

These requirements apply to systems with up to 25 users. For systems with 25+ users, contact your Resolver account manager for more information.
Depending on the size of the Perspective database, more disk space may be needed for Workflow.

This requirement only applies if using Dispatch.

Only SQL Server Enterprise Edition is supported for indexing on audit tables.

OO0~ WN e

Notes:
. Net.TCP binding on port 808 is required only if using DispatchlLog.
. For the best Dispatch experience, it's recommended that dispatchers run the application on two monitors with a resolution of 1920x1080.
. Time synchronization is required for Dispatch visual alerts. NTP is strongly recommended for Hosted customers.
. For the best performance, do not run the Indexer on the same server where the database is hosted.
Deployment Note: The Perspective client is deployed as a ClickOnce application, launched from IE. It has a zero client footprint and doesn’t require administrative rights to
launch.
Network Note: If single sign-on authentication or add from Active Directory is used, Active Directory Services must be enabled on the Perspective Web Server.
Internet Note: Internet connectivity on the Client Machine is required for full functionality.
Internet Note: Internet connectivity on the Client Machine is required for full functionality.
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Perspective Installation Guide Standard Install

Standard Install

SQL Database Server

1. Ensure Microsoft SQL Server 2012 SP3 or better has been installed.
2. Install the Perspective database:

a. Launch Microsoft SQL Server Management Studio.

b. Right-click databases and select Restore Database.

c. Under From Device, click the Browse (...) button and browse to the appropriate database:

default, sample, or system.

Note: Standard backups are found in Perspective Install > Database Setup > New. If you're

unsure which database to use, contact your Perspective Administrator.
d. Click OK.
e. Check the Restore option.

f. Enter a database name in To Database, and then click OK. The database should now appear in

the database list.
3. Create a new SQL user that will be used by Perspective to connect to the SQL Server:

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the

Security node, right-click Logins, and select New Login.

m © Resolver Inc. Do not distribute. Page 2 of 73
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‘__,;. Microsoft SOL Server Management Studio Express

File Edit Wew Tools Window Community Help
Qtewcery | (3|3 | S Wi H @ BB BES,
0 rer Summary | - X
&0 a0 —
BNeEwTE L!]EI,-:’T::::
=) [ BETAISQLEXPRESS (SQL Ser a |
1 Databases i .
= [ Security D Loglns
=R oains - ETA|SOLEXPRESS SecuritylLogins 10 Ttamfs)
& P.c[ Mew Login, .. o !
frs| EE Filter SN
o] BE] I Created I -
o] BU Reparts ¥ Trackclient 11122010
;@BL Refresh A\SQLServer200SMSFTEL...  11/7/2007
e I
81S0LServer2005MSS0LL...  11/7i2007
» it
? :I iﬂl:giix:‘l A0 BUILTING Adrmimistratar s 11/7f2007
; - 8 BUTLTIN Uisers 11742007
E Za '_P.\INTERN.C\L'I,an.Fradette 3/5/2009
(P =
[ Server Roles }.‘ NT AUTHORIT\":NETWORK SE.. 11::?::200?
Credentiat A NT AUTHORITY|SYSTEM 1172007
— = I:J re,—ue'-1 Ia. 8 i /’n L T2%) 11 readlenns LI
| 4
Ready 4

b. Inthe Login — New form, under the General page, type in the Login Name and modify the rest

of the options according to your preference.

c. Open User Mapping. Ensure the account has db_owner role membership rights, then click OK.

E Login - New !E
Selectapage % Scipt ~ 74 Help
5 General
4 Server Roles L
& User Mapping Users mapped to this login:
5 Securables Map | Database | Uses | Default Schema [2]
5 Status r model
¥ | Pespective2lSample | remnyakova _IJ
W ReportServer$SALExpr...
r ReportServer$SOLE ... ﬂ
I”| Guest account enabled for: Pe
st e et o Peomee s
Server: (1 db accessadm
BET&M\SOLEXPRESS 7 db bad tor
Conrection: [1 db_datareader
INTERMNAL \svetlana remnyakoy] |] db_datawiiter
) ) ) [ db_ddladmn
11! Vigw connection properties [ db_denyd i
v
Fieady —
v/

0K I Cancel |

4
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Database Restore (Dispatch Scheduling Service and Service

Clustering)

Note: This section applies to users installing an edition of Perspective with the Dispatch application. If

you're not installing an edition of Perspective with Dispatch, skip this section.

Follow these steps below to restore both the Dispatch Scheduling Service database and the Service

Clustering database.
1. Open SQL Management Studio.

2. Right-click Object Explorer and click Restore Database.

Object Explorer

Connect~ 3 3J m 7 7] .5
= Ijj 2lk7dv-2012a (501 Server 11.0.2100 - =a)

= Mew Datab
5 ew Database...
Ls Attach...

3]

— Restore Database...

o |

[E3]

Restore Files and Filegroups..

2]

1

=

Deploy Data-tier Application...

1K

3]

1

Import Data-tier Application...

1E

Start PowerShell

2]

1

=

1K

Reports ]

=3 =3

[E3]

i Refresh
| | Perspective_43_UetaultwithLicense

[J Perspective 46 2 Default

I | Darcnartine AR 7 Nefaultl lnnrada

B ®

a

3. Navigate to the location of Dispatching Schedule Service database backup file.

Note: Standard backups are found in Perspective Install > Database Setup > New. If you're unsure
which database to use, contact your Perspective Administrator.
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Uz Restore Database - SchedulingServiceDatabase = =
/1 Atail-log backup of the source database will be taken. View this setting on the Options page.
Select a page SScript - L’jHeIp
A General
A
£ Files Source
A Options )
() Database:
® Device: C:\temp\SchedulingServiceDatabase.bak
Database: SchedulingServiceDatabase W
Destination
Database: SchedulingServiceDatabase v
Restore to: The last backup taken (March 28, 2016 12:536:23 PM) Timeline...
Restore plan
Backup sets to restore:
Restore  MName Component  Type Server Database
SchedulingServiceDatabase-Full Database Backup  Database Full  2LK74V-2012A  SchedulingSeny
‘Connection
B 20kT4v-2012a [sa]
View connection properties
Progress
£ >
Done
@ Verify Backup Media

4. Click OK to restore

Create a new SQL user that will be used by Perspective to connect to the SQL Server:

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the Security

node, right-click Logins, and select New Login.
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B Microsoft S0L Server Management Studio Express

File Edit Wew Tools Window Community Help
Qo || BEHNE S RERE S,
¢ arer Summary] - X
B TE @ E e T EE
=) [ BETAISQLEXPRESS (SQL Ser a |
1 Databases i .
= [ Security D Loglns
=R oains - TETAISQLEXPRESS) Security|Logins 10 Ttamfs)
& P.c[ Mew Login, .. o |
frs| EE Filter SN
o] BE] I Created I -
o] BU Reparts ¥ Trackclient 11122010
?_:ﬂ BY Refresh A\SQLServer200SMSFTEL...  11/7/2007
e I
81S0LServer2005MSS0LL...  11/7i2007
» it
? :I iﬂl:giix:‘l A0 BUILTING Adrmimistratar s 11/7f2007
; - 8 BUTLTIN Uisers 11742007
E Za '_P.\INTERN.C\L'I,an.Fradette 3/5/2009
[ Server Roles g‘ NT F\UTHORIT\"}INETWORK SE.. 11::?::200?
Credentiat A NT AUTHORITY|SYSTEM 1172007
— = I:J re,—.|EI-1 Ia. 8 i /’n L T2%) 11 readlenns LI
| 4
Ready 4

b. Inthe Login — New form, under the General page, type in the Login Name and modify the rest

of the options according to your preference.

c. Open User Mapping. For both the Dispatch Scheduling Service and Service Clustering
databases, ensure the account has either db_owner OR db_datareader and db_datawriter role

membership rights, then click OK.

E Login - New !E
pages 8 Scipt ~ L5 Help
& General
A Server Roles L
2 UUser Mapping Users mapped to this login:
%4 Securables Map__ | Database | User | Default Schema [2]
5 Status - mode!
¥ | PespectiveZlSample | remnyakova _IJ
- ReportServer$SOLExpr_..
W ReportServer$SALExpr... LI
™| Guest aceount enatied|fon Perspective?] Sample
Database role membership for: Perspective2] S ample
Server [ db_accessadmin
BETA\SOLEXFRESS [ db_bac slor
Connection: [ db_datareader
INTERMAL \svetlana remnypakoy| | db_datavmber
. ) ) [ db_ddladmn
27 View connection properties | — 4 denwdsh ;
v
Ready :
v/

0K I Cancel |

4
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Standard Install

SQL Reporting Services

1.  Ensure that SQL Server Reporting Services is installed.

2. From the Perspective install directory, copy the Reports Setup folder and all subfolders to a

temporary directory on the Reporting Services computer.

3.  Edit the PublishServerReports.bat file in the temporary directory. Before making any changes, save

a backup copy of the original PublishServerReports.bat file.

e Edit databaseServerName to <Name_of_Database_Server>.

e Edit databaseName to <Name_of_Database>.

e Edit databaseUserld to <sql_User_Account>.

e Edit databasePassword to <sqglUser_Password>.

4.  Save changes and run the PublishServerReports.bat file to publish reports to the Report Manager. If

the file fails to run, see Troubleshooting Tips.

5. Browse to your Reporting Services Web site (e.g. https://localhost/Reports/).

a. On the Contents tab, click the Perspective folder.

b. Click Properties, Security and New Role Assignment, then Edit ltem Security.

(f Report Manager - Windows Internet Explorer [_[al =]
@:\/' |g http:,i,I’Ioca\host,iReports;’Pages,iFoIder.aspx?Ilj @ )| X% Ii" Live Search L=
Fle Edit ‘Wew Favorites Tools Help
f\? Favarites (& Report Manager | |
Home | Help =
SOL Server Reporting Services l —I
|_j] Home = ) Search for: Gol
< Perspective
X Delete || AP New Rale, Assignment | f},Revert to Parent Security
General :U
sacurity I Group or Userd Role(s)
[T Edit BUILTINMAdministrators Content Manager
[T Edit BUILTINWUsers Content Manager

c. Enter a Windows Service Account for the Perspective application to use when connecting to

Reporting Services. Create a new local user, if you do not have one already. Ensure that the

password is not set to expire.

m © Resolver Inc. Do not distribute.
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Standard Install

d.

Select the Browser role and click OK.

f‘ Report Manager - Windows Internet Explorer M=l E3

@:-_:.' |g, http:,l’,l’Iocalhost,l’Reports,l’Pages,l’EditGroup.aspx'j B |9 X Il’_"Live Search

File Edit Wiew Favorites Tools Help

{3 Favorites @ Report Manager | |

rﬁ SOL Server Reporting Services
@i

Home | Help «|

New Role Assignment Search for: @

Use this page to define role-based security for Perspective.

Group or user name: |remnyakova

Select one or more roles to assign to the group or user,

I~ Roled Description

[ Browser May view folders, reports and subscribe to reports.

[T Content Manager  May manage content in the Report Server, This includes folders, reports and
resources,

I~ My Reports May publish reports and linked reparts; manage folders, reports and resources in a
users My Reports folder.

I~ Fublisher May publish reports and linked reports to the Report Server,

I~ Report Builder May view report definitions.

o] (o]

Perspective Services (Application Web Server)

Completing the following steps will install Perspective Services, Integration Services, Real Time Services,
and Web Portal.

Server Manager * Dashboard

78 Dashboard WELCOME TO SERVER MANAGER

1 Local Server
i A Servers
W§ File and Storage S

o us

2

Add Roles and Features Wizard [=T=l=]|

Select ane or more roles to install on the selected server

Hi All servers 1

@ Manageability
Events

|

Performance

BPA results

<Previous | | Next> Cancel

TN Enable IIS 6 Metabase Compatibility (image is taken from Windows Server 2012).

m © Resolver Inc. Do not distribute.
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Perspective Installation Guide Standard Install

&\ Ensure Internet Information Services (IIS) is installed and that IIS has WCF Activation
turned on and, if installing an edition of Perspective with Dispatch, ensure the WebSocket

Protocol is installed (image is taken from Windows Server 2012).

Server Manager =

Iy Manage T
DESTINATION SERVER
Select server roles TVGDABPDWHSW2LX.pom2000.com 1~
Before You Begin Select one or more roles to install on the selected server.
Installation Type Roles Description
Server selection — - E ~| IS 85 and ASP.NET 4.5 support
b [®] Security (8 of 9 installec) writing server applications that
4 [m] Application Development (5 of 11 installed) communicate over the WebSacket

Features Protocol.

[ .NET Extensibility 3.5

\NET Extensibility 4.5 {Installed)

[ Application Initialization =

[ Asp

[] ASP.NET35

ASP.NET 4.5 (Installed) _

O cal = )

ISAPI Extensions (Installed) fide

ISAPI Filters (Installed)

[ Server Side Includes

ebSocket Protocol (Installed)

b [ FTP Server "
<] " [ [>
IS 1
¢Previous | [ Net> | [ sl | [ Cancel Wtanageatility
ven! I:veng Events
Services Services Services
Performance Performance Performance
BPA results BPA results

1. From the Perspective Install > Web Service Setup directory, run as an administrator

Perspective.Services.exe. To complete the setup, follow the wizard's guidelines.

a. If the User Account Control screen pop-up window appears, click Yes.

Program name:  Perspective.Senvices
File origim: MNetwork drive

(%) Show details Ve || Mo

This file is in a location outside your local network, Files from locations you don't
recognize can harm your PC. Only run this file if you trust the location.

Change when these notifications appear

b. Wait for the Perspective Service Setup Wizard to start. Click Next.

m © Resolver Inc. Do not distribute. Page 9 of 73



Perspective Installation Guide Standard Install

c. Read the License Agreement. If you accept the terms and conditions, select the appropriate

radio button, and click Next.

d. The default install path for the Complete install is C:/inetpub/wwwroot/Perspectiveb.3.1. Ensure

Complete is selected, and click Next.

e. Inthe following screen, click Install to confirm the installation. Wait while Perspective Services

is being installed.

f.  If Visual C++ 2010 SP1 Runtime Libraries (x64) is not installed, you will be prompted to install
the Runtime Libraries. If already installed, skip to step 2i.

Installing Perspective Service
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Perspective Service, This
may take several minutes.

Status:
Instaling Microsoft Visual C++ 2010 SP1 Redistributable Package (xG64)

Installshield

g. Accept the Terms and Agreements, and click Install.
h. When the installation is complete, click Finish.

i. Perspective Services installation will continue.

j.  Click Finish once the installation is complete.

Only check the Show the Windows Installer log box if you want to see where the files have

been installed.

m © Resolver Inc. Do not distribute. Page 10 of 73



Perspective Installation Guide Standard Install

Set Up Secure Sockets Layer (SSL) on Internet Information Services (1IS)

To set up SSL on IIS, follow the instructions on the Microsoft IIS website.

Configure Connections Using Service Manager

1. From the Perspective Install > Web Service Setup directory, run Perspective.ServiceManager.exe as

an administrator.
a. If the User Account Control screen pop-up window appears, click Yes.
2. Theinstallation wizard appears. Click Next to continue.

a. Read the License Agreement. If you accept the terms and conditions, select the appropriate

radio button and click Next.
b. You can change the installation directory, or click Next for default file path

c. Inthe following screen, click Install to confirm the installation. Wait while Perspective Service

Manager is being installed.
d. Click Finish once the installation is complete.

° Only check the Show the Windows Installer log box if you want to see where the files have

been installed.
3. From the Start menu, or desktop, launch Perspective 5.3.1.1 Service Manager as an Administrator.

Note: This process may trigger Windows' UAC (User Access Control) security feature. If prompted,

click Yes.

m © Resolver Inc. Do not distribute. Page 11 of 73
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Standard Install

&

() Show details

User Account Control

@] Do you want to allow the following program to update

software on this computer?

@ Program name:  Perspective 5.3 Service Manager
Verified publisher: Resolver Inc.
File crigin: Hard drive on this computer

Yes | | MNo

Change when these notifications appear

If you changed the installation path, you may be prompted to select a Perspective configuration file.

Navigate to the installed location of Perspective Services, select

Perspective_[Your_Business_ID].config (default location:

C:inetpub\wwwroot\Perspectiveb.3.1\PerspectiveServices) and open the configuration file.

Note: If you're using Perspective On Premise and your organization’s business ID is Default, the

configuration file will be saved as Perspective_Default.config.

You'll be prompted for database information.

Database Connection B
Perspective |

Connection 1D

|Sample
SOL Server

[ASUANZIALLNE2013 =l

¥ Primary Connection

Default Language D

o =

© windows Authentication

& S0L Authentication
Username:

Pazzword:

|Perspective

[ratabazes

oK Cancel

m © Resolver Inc. Do not distribute.
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4.  Enter a new name for Connection ID.

Note: The Connection ID cannot contain the word “Default’.
5. Inthe SQL Server lookup list, select your SQL Server or type the name of your server in the text box.
6. Leave Default Language ID set to 0, unless instructed otherwise by Resolver.

7.  Ensure SQL Authentication is selected, and enter the SQL Username and Password created when

installing the database.
8. Select your Perspective database from the Databases lookup list.

Note: If you receive an “Unable to connect to the named server” message, you have entered either

the wrong SQL server name or credentials.
9. Click OK to save and add the primary connection.

10. In the top field, enter your Company Name, as listed on the email provided to you with your license

keys.

11. Enter the Master Key that applies to the Company Name entered. Note, the Master Key is case-

sensitive.

12. Click the Validate button. The fields below will indicate the number of active licenses, License Expiry
Date, Product Level and specifications of individual Licensed Modules (i.e., Product, Number of

Users and Expiry Date).

Note: The Allow connections to Perspective License Service box is checked by default. Unchecking
this box means a license file must be imported when you click the Validate button. If you don’t have

a license file, contact Technical Support at 1-877-776-2995.

m © Resolver Inc. Do not distribute. Page 13 of 73
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13.

14.

15.

16.

17.

18.

C

[PPu |

Master Key:

[PXPONLE 1230400150000 |

[ Allow connections to Perspective License Service

Licensed To License Expiry:
PPM 2000 12/31/2099

|User Defined Fields Product Levek: Number Of Licenses:
E
Perspective EIM 1000 Concurrent

Enterprise Incident Management
Downloads
Licensed Modules:

Visual Analysis 12/31/2089

Mobile \nieb
PPM Partner NonConsumer
Case and Investigations

Dashboard

Call Taker Form

Mobile Apple i0S
\nleb Portal

Language Packs

Mapping

Open the Database component from the menu on the left and double-click your database name, or

click the Edit button.
Open the Report Service tab and type the report server URL in the Report Server URL box.
Enter the name of your Reports Folder.

Proceed to the Report Service User section below. Enter the Domain, Username and Password that

were granted browser rights when setting up the server-side reports.

Click the Test button. You should receive a prompt telling you the URL is valid. If not, confirm your
configuration is correct and try again. Please refer to troubleshooting section for SQL reports if you

receive an error and message.

Click OK.
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Standard Install

[ Perspective | Analysis Expert Connection | Services |

Authertication Mode |

Report Service Host
Report Server URL

|http:ﬂrrry5ewer,-’reportserver

]

Reports Folder

| Perspective

Domain Usemame

| User_Domain_Name | | User_Login_MNAme|

Password

Device Manager

Dievice Manager URL

| Validate URL

0K H Cancel

19. Select the Configuration component from the Perspective Service Manager menu.

20. To encrypt the Perspective_Default.config file, check the Encrypt Configuration? box.

21. Open the Client-Side Configuration tab.

22. Enter the Download URL for Client-Side Reports, if needed, for the client reports configuration files

to update automatically (i.e., https://<servername>/perspectiveservices/client).

m © Resolver Inc. Do not distribute.
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/" Configuration }/ Client-Side Configuration rNcﬂica(ion rh&tachmeﬂts | Services | AE Tools I

i Client Reports Configurati
Download URL for Client-Side Reports:
[hND:h’lwahostz‘perspectivesewioesiclienn’

Location of updated client-side reports:

[ Browse |

r Reports Exists On Senver

Client-Side Repaits Versi..

40,1126

Updste Freports To Senver

Save Cancel

23. Click Save.
Note: If you do not click Save, you will be prompted to save all changes that have been made.
24. Close the Service Manager by clicking the Cancel button, or clicking the X button on the caption bar.

25. RestartlIS.

& Advanced Configurations Warning
Additional options in the Service Manager are not covered in this step-by-step Standard
Install walkthrough. For the list of supported advanced setup configuration options,
please refer to the Advanced Configurations section. It's recommended that all setups
follow the standard setup procedures outlined in this section as an initial starting point.
Advanced features can be configured as needed after the standard configuration has

been verified to run correctly.
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Scheduling Services

Note: This section applies to users installing an edition of Perspective with the Dispatch application. If

you're not installing an edition of Perspective with Dispatch, skip this section.

1. Navigate to install location of the scheduling service. If you completed a default installation of
Perspective Services, it's located at C:\Program Files\Resolver Inc\Perspective\5.3.1\Dispatch
Scheduling Service. If you completed a custom installation, this location is the path that was
specified in the InstallShield Wizard.

i Perspective 5.0 Service - InstallShield Wizard -

Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description

Perspective Services

Intepraticnn Cervices Creates scheduled dispatches,
9 ) purges dosed dispatches and

Real Time Services removes entity locks,

Web Partal

Dispatching Schedule Service

This feature requires 14MEB on
your hard drive.

Install to:
C:YProgram Files\Resolver Inc\Perspectivel\s. 0\Dispatch Scheduling Service',
Installshield

| Help | | Space | | « Back || Mext = | | Cancel |

2. Open the Connections.xml file.

3. Enter the service folder information to show the Integration Services virtual directory (i.e.
<servername>/integrationservices).

Note: If Scheduling Services and Integration Services are installed on the same machine, the Service
Folder element(s) in the Connections.xml file must contain either an IPv4 address or the localhost
alias.

4. Save your changes to the Connections.xml file, then close.
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5.  Open the SchedulingServices.exe.config file.

6. Under appSettings. enter the database connection string to point to the Scheduling Service
database. For example:

<add key="DataBaseConnectionString" value="Data Source==<dbserver\dbinstance>;Initial
Catalog=<dbname>;user id=<user>;password=<password>;Application Name=Integration
Services" />

7. Save your changes to the SchedulingServices.exe.config file then close.
8. Open Windows Services.

9. Click on Dispatching Schedule Service.
= Senices L= o I

File Action View Help

L IR EREIE b mnD

£ Services (Local) O Sxiees (Local)
Dispatching Schedule Service Mame - Description Status Startup Type Log On As ~
. Device Install Service Enablesac. Manual (Trig.. Local Syste...
Start the service 5 Device Setup Manager Enables the ... Manual (Trig... Local Syste...
L. DHCP Client Registers an... Running  Automatic Local Service
Description: . Diagnostic Policy Service The Diagno.. Running  Automatic (D.. Local Service _
Creates scheduled dispatches, purges % Diagnostic Service Host The Diagne... Manual Local Service =
closed dispatches and removes entity 7} Diagnostic System Host The Diagno... Manual Local Syste...
‘UCk.s' |fth\s service is stopped, these . Diagnostics Tracking Service  The Diagno... Running  Automatic Local Syste...
services will not function properly. . - - - -
* 3 Dicpatching Schedule Service Creates sch... Automatic Local Syste...
. Distributed Link Tracking Cl... Maintains li.. Running Automatic Local Syste...
. Distributed Transaction Co.. Coordinates.. Running  Automatic (D.. Network 5.
£ DNS Client The DNS Cli...  Running  Automatic (T... Network 5.
L Encrypting File System (EFS)  Provides th.. Manual (Trig.. Local Syste...
. Extensible Authentication P... The Extensi... Manual Local Syste...
L4 Function Discovery Provide.. The FDPHO... Manual Local Service
. Function Discovery Resourc... Publishes th... Manual Local Service
= Group Policy Client The service .. Running  Automatic (T... Local Syste...
. Health Key and Certificate ... Provides X.5... Manual Local Syste...
L+:Human Interface Device Ser... Activates an... Manual (Trig.. Local Syste..
« Hyper-V Data Exchange Ser... Providesa.. Running Manual (Trig.. Local Syste...
L& Hyper-V Guest Service Inter... Providesan ... Manual (Trig... Local Syste...
L Hyper-V Guest Shutdown 5.. Providesa.. Running Manual (Trig.. Local Syste..
&4 Hyper-V Heartheat Service Monitorsth... Running  Manual (Trig... Local Syste... ~
\Extended I&Standard/

10. Click the I icon or right-click Dispatching Schedule Service then click Start.

Configure Device Manager for Connect

Note: This section applies to users installing an edition of Perspective with the Dispatch application,
along with Connect 2.0. If you're not installing an edition of Perspective with Dispatch and Connect, skip

this section.
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In order to view the Connect devices in Dispatch, the Device Manager URL in the
Perspective_default.config file must be edited to show the Connect server. Note that Perspective should
only use an instance of Connect as its Device Manager if the Connect instance is using Perspective’s

instance of Integration Services for authentication.

Note: To successfully configure the Device Manager, the Perspective_default.config file cannot be

encrypted through Service Manager.

1. Using Notepad, open the Perspective_default.config file. By default, it can be found at

C:linetoublwwwroot|Perspective5.3.11PerspectiveServices.
2. Scroll down to the bottom of the file and locate the <DeviceManagerURL> tags.

3. Change the URL in the tags to point to the Connect server.

<DeviceManagerURL>https://<ConnectServeriames/api/</DeviceManagerURL>
</PerspectiveConfig>

Note: Only one Device Manager URL is permitted per config file.

4. Click File > Save to save your changes, then close the file.

Real Time Service Configuration (DispatchLog)

If you're installing a version of Perspective that includes DispatchLog, additional configuration to Real

Time Services is required.

1. Navigate to your IIS Settings.

2. Expand Site and expand Default Web Site.

3. Right-click PerspectiveRealTime then Manage Application >Advanced Settings.
4.  In Advanced Settings, add http,net.tcp in Enabled Protocols. Click OK.

Note: Port 808 is used by default
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LS|

® [ &+ cmanizsoc » Application Poots

Internet Information Services (11S) Manager
Advanced Settings

File View Help

e-H |z I8
.8y Start Page
495 PPVR0DOXX
[} Application Pools
4.d Sites
4 Defoult Web Site
b1 aspnet_client
1 IntegrationServices

3
b [] Perspective

b - PerspectivePortal

b (¥ PerspectiveRealTin
b F PerspectiveService

< m >

Ready

Wil’ Appli

This page lets you
worker processes,
Filter:
Mame -
L} NET 45
53 NET w5 Clas|
3 DefaultAppPol
. ntegrationSer
i PerpsectiveRe
3 PerspectivePof
I Perspectivesel

Features View

- |8 x
CEEXE

4 (General)
Application Pocl PerpsectiveRealTime4.0
Physical Path Clinetpub\wwwroot\Perspective\Se(
Physical Path Credentials
Physical Path Credentials Logon ClearTest |ociated with
Preload Enabled False a
Virtual Path [PerspectiveRealTime
4 Behavior —
[ErebedProtocos ——— JEET ===
1
1
u
i
u
Enabled Protocols

Enzbled Protocols specifies the protocols that requests can use to access an
application. The default value is 'http', which enables both the HTTP and ...

@ Add Application Pool...

Set Apglication Pool Defaults...

Application Pool Tasks

Stop

taw

Recydle..

Edit Application Pool
Basic Settings.
Recycling...
Advanced Settinge...
Rename

X Remove

View Applications

@ Hep

Online Help

.

5.  Go to the inetpub/wwwroot/Perspectiveb.3.1/PerspectiveServices directory and edit the

Perspective Default Config file. To do this, find the Perspective Real Time URL, and replace the

localhost with a fully qualified server name.

Note: Additional exceptions for Windows and network firewall may be required.

Client Machines

Accessing Perspective Desktop Client

1. Ensure Microsoft .NET 4.5.2 Framework is installed on the client machine.

2. Browse to the Perspective Services URL:

e https./<servername>/PerspectiveServices <servername> refers to the Perspective Web

server installed in the previous section.

a. Click the Perspective icon.
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PERSPECTIVE:

RO

Perspective Dispatch Dashboard Portal

Incidents & Investigation Managing Events in Real Time Personalized Visual Metrics Web based Security Central

b. Click Run.
c. Ifyou're using the MSI Package installer, follow the procedures below.

i. Browse to the Perspective Services URL (e.qg.

https.//<servername>/PerspectiveServices/7opt=0)
e Ifyou're using ?opt=1, only the ClickOnce installer will be displayed.

e If you're using ?0pt=0 or if Java Script is disabled or the Web Service is not a trusted

site, both the ClickOnce and MSI Package installer will be displayed.

ii. Download the MSI Package and follow the on-screen instructions. If you experience any
problems during the download of the MSI Package or the installation of the MSI client, call
Technical Support at 1-877-776-2995 for assistance.

Note: Following the configuration of the Web Server, please ensure application initialization has
taken place so that end users do not experience delays with initial page loading. After any IIS
reset or configuration, navigate to httos.//<servername>/IntegrationServices/service.svc to

begin the application initialization.

3.  After Perspective downloads and installs, you might be prompted to enter a URL. The URL should
be automatically populated.If so, move to the next step. If not, enter your Perspective Services URL
as before: https://<servername>/PerspectiveServices. <servername> refers to the Perspective Web

server installed during the installation of Perspective.
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Now you should be able to test the default Perspective logon. From this point onward, users must

navigate to the Perspective Services URL to launch the Perspective application.

Perspective Default Logon

User Name: Admin

Password: Security

To create a shortcut to the application on the client machine’s desktop, proceed as follows:
1. Navigate to the Perspective Services URL.
2. Right-click the Launch Perspective button and select Copy Shortcut.

3. Right-click the client desktop and select Paste Shortcut.

£\ Default Admin Master vs. Users with Administrator Rights

As of Perspective Version 3.3, there are differences between the default Admin
Master account and a Perspective User with Administrator rights. Specifically, the
Admin Master has select features available that other Users, even with Administrator

rights, do not.

However, the default Admin Master can only access the Administration and
Dashboard panels of Perspective. Other components are unavailable to the Admin

Master; this account cannot be used for data entry.

Accessing Perspective Web Portal

Users can’t access the Web Portal until an administrator has set up workgroups within Perspective that

allow imports. Once the workgroups are set up, the Web Portal can be configured.
To configure your Web Portal:

1. Open an Internet browser (either Google Chrome or Internet Explorer 11 or greater).
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2. Click Portal on the launch page or navigate to your Portal Services URL:

https://<servername>/PerspectivePortal. <servername> refers to the web server installed during the

installation of Portal.

3. Administrators will be required to log in to set up the Web Portal. Refer to the Perspective Web

Portal User Guide for additional information.
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Testing Perspective Implementation

Once you have completed the steps outlined on the previous sections, please go through the following

steps to ensure that all Perspective’s components have been set up properly.

Note: Following the configuration of the Web Server, please ensure application initialization has taken
place so that end users do not experience delays with initial page loading. After any /IS reset or
configuration, navigate to https./<servername>/IntegrationServices/service.svc to begin the application
initialization.

1.  Go to the Perspective Services URL and confirm that the page loads properly:

https://<localhost>/perspectiveservices, where <localhost> is the appropriate local host address on
your network.

2.  Goto the Perspective Services page and confirm that the page loads properly:
https://<localhost>/perspectiveservices/service.asmx, where <localhost> is the appropriate local
host address on your network.

3.  Go to the Report Manager page and confirm that the page loads properly:
http://<reportservername>/reports, where <reportservername> is the appropriate address for the
reports server on your network.

Note: If your Report Manager page does not display correctly, run the PublishServerReports.bat file
included in the Perspective Install > Reports Setup folder.

|= 1o .
@@‘5} httpsi// reportsservername /Reparts/Pages/Falder.aspx LP-a G” & Home - Report Manager | ‘ # & It
Home | My Subscriptions | Site Settings | Help
SQL Server Reporting Services
—& Home [Search 2]
4 New Folder . New Data Source ESi Report Builder (4 Folder Settings ¢ Upload File |4 Details View

—E_].] Perspective

4.  Log on to the Perspective client—preferably not on the server itself—using your Perspective
administrator user name and password.

5. Once you have logged on successfully, click on the Reports button in the Navigation pane (on the
left-hand side of the screen) and confirm that all reports are listed. The easiest way to confirm that
the client-side reports are working is to verify that there are reports listed under the Detail Reports
heading, such as the Incident, Person and Vehicle Reports.

6. To also confirm you are connected to the correct database, run the Workgroup List report and verify
the workgroups listed.

m © Resolver Inc. Do not distribute. Page 24 of 73



Perspective Installation Guide Testing Perspective Implementation

7. To confirm that the server-side reports are working, try running the Test Report under the
<Administrative Only> node listed. If you receive an error message, see the Troubleshooting

Perspective & SQL Reporting Services article on the Resolver Support site for more information.

Note: Both the Report version and database version should display as 5.3.1.1.

m © Resolver Inc. Do not distribute. Page 25 of 73


https://support.resolver.com/hc/en-ca/articles/208662796-Troubleshooting-Perspective-SQL-Reporting-Services
https://support.resolver.com/hc/en-ca/articles/208662796-Troubleshooting-Perspective-SQL-Reporting-Services

Perspective Installation Guide

Advanced Configurations

Advanced Configurations

Perspective offers your organization a number of advanced configuration options. Before attempting to

implement any of the following options, we recommend that you complete the standard installation first,

then contact Technical Support at 1-877-776-2995 or support@resolver.com for further instructions.

SSL on Your Web Service

To secure and encrypt data sent to and from the Web service to

client machines.

Windows Authentication

To allow users to log on to Perspective and to connect to SQL

service using their Windows authenticated account

IS Compression

To compress information sent from Web services to the client.
(Recommended for installs with remote users who are not connected
directly to the network. If all users are internal, compressing data
may take longer than sending uncompressed data over a high-speed

network.)

Transparent Data

Encryption

For encrypting data at rest (for use with Microsoft SQL Server
Enterprise Edition only).

Setting up Sample/Training

Database

Default setup supports one database only. If additional databases
are required, these can be set up with assistance from Technical

Support.

AE Mirroring

For sites with high volumes of data that require SQL intensive

searches to be executed against a separate SQL server.

Custom Pagination

m © Resolver Inc. Do not distribute.

By default, the pagination feature is set to 100 records per page.
This number can be modified (to any value from 20 to 1000 records
per page) by manually editing the
<PaginationPageSize>100</PaginationPageSize> tag in the

Perspective_Default.config file.
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Custom Legal Notice and

Privacy Statement

To customize Perspective’s legal notice and/or privacy statement for
your organization, navigate to the Legal folder in the Perspective
Services Virtual Directory, open the LegalNotice.mht or
PrivacyStatement.mht file in an HTML editor (such as Microsoft
Word), apply your edits, and save the file as an MHTML document

with the original file name.

Change Default Install

Location

To change the default installation location, select Custom from the
Setup Type screen (when installing Perspective Services). Click Next.
Select a feature and click the Change button. Then, pick the new

install location. Click Ok.

Change Caching Options of
Portal

The caching duration is set by default to 20 minutes. However, this
can be changed by accessing the web config file of Perspective
Portal. The duration is in minutes, and can be between 1-1400

minutes.

Note: Caching should always be enabled unless you are

troubleshooting. Disable it by setting caching=false.

Directing to Fully Qualified

Servers for Portal

Go to C:/inetpub/wwwroot/Perspective5.3.1/PerspectivePortal and
edit the web config file. Find the external web address and update it

to a fully qualified server.

Set Up Additional Features Using Service Manager

Perspective Service Manager is an external application available only on the Web server hosting

Perspective services. It is used to manage configuration files, databases, licenses and keys, as well as to

set up a number of important features in Perspective (i.e. email and mass notifications, attachments,

Quick Find indexing, User Defined Fields, Custom Search integration, and Integration Services URL).

To access Perspective Service Manager, go to C:\Program Files\Resolver Inc

Inc\Perspective\b.3.1\ServiceManager > Perspective.ServerManager or open it from the Startup menu.
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Remember to complete each editing action in Perspective Service Manager by clicking Save Changes. To
implement your settings in Perspective, restart Internet Information Services (IIS) (and the Perspective
Web server). Note that restarting IS will affect anyone currently logged on to Perspective. Ensure that all

users have saved their work and exited the program prior to completing this step.

Configuring HTTP Compression for ClickOnce Packages

Configuration: Windows Server 2012 R2

1. Verify that Static and Dynamic Content Compression Roles are enabled (done through server

manager).
= Add Roles and Features Wizard = =] -
Select server roles 522012201 spa2008 com

Before You Begin Select one or more roles to install on the selected server.

Installation Type Roles Description

Server Selection T T S mmmms s oo ~ Performance provides infrastructure
[[] Remote Access for output caching by integrating
the dynamic output-caching
capabilities of ASP.NET with the
static output-caching capabilities
that were present in IS 6.0. lIS also
lets you use bandwidth more
effectively and efficiently by using
commaon compression mechanisms
such as Gzip and Deflate.

[] Remote Desktop Services

[ Volume Activation Services

3 pplicatio
b [] FTP Server
[] 115 Hostable Web Core

< n ¥

< Previous | | Next > Install Cancel

2. InlIS Manager, click on your server.
3.  Under IS, click Compression.

4.  Verify the Enable dynamic content compression and Enable static content compression checkboxes

are selected.
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Connections
€. - &
€5 Start Page
95| DEV2012R2 (INTERNAL\stefan.krupa)

() Application Posls Enable dynsmic content compression
b ool Sites

le Compression

Use this feature to configure settings for compression of respenses. This can improve the perceived perfermance of a website greatly and reduce bandwidth-related charges.

Enable static content compression

Static Compression

Only compress files larger than (in bytes):

Cache directory:

[se5ystembrivestiinetpubitemp\ls Temporery Compressed Files | l:l

Per application pool disk space limit (in ME):

100

5. In IS Manager, click on your server.

6. Under IS, click MIME Types. Here you can see all file extensions and their associated MIME Types.
The basic MIME Types for ClickOnce deployment are:

.application —> application/x-ms-application
.manifest —> application/x-ms-manifest

.deploy —> application/octet-stream

7.  For the above MIME Types to be compressed, you need to edit the applicationhost.config file which

can be found in the %windir%\system32\inetsrv\config folder.
8.  Open this file. Under the http compression tag and under dynamic types and static types, add:

<add mimeType="application/octet-stream" enabled="true" />
<add mimeType="application/x-ms-application" enabled="true" />

<add mimeType="application/x-ms-manifest" enabled="true" />
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<httplompression directory="%S%ystemDriveX¥\inetpub‘temp\IIS Temporary Compressed Files":»
<scheme name="gzip" dll="%Windirf¥\system32\inetsrvigzip.dll" />
<staticTypes>

<add
<add
<add
<add
<add
<add

mimeType="text/*" enabled="true" />
mimeType="message/*" enabled="true" />
mimeType="application/javascript” enabled="true" />
mimeType="application/atom+xml"” enabled="true" />
mimeType="application/xaml+xml" enabled="true" />
mimeType="application/octet-stream” enabled="true" />

<add mimeType="application/x-ms-application"” enabled="true" />
<add mimeType="application/x-ms-manifest" enabled="true" />
<add mimeType="*/*" enabled="false" />

</staticTypes>

<dynamicTypes>
<add mimeType="text/*" enabled="true" fﬂ

<add
<add
<add
<add
<add
<add
<add

mimeType="message/*" enabled="true" />
mimeType="application/x-javascript" enabled="true" />
mimeType="application/javascript” enabled="true" />
mimeType="application/octet-stream” enabled="true" />
mimeType="application/x-ms-application"” enabled="true" />
mimeType="application/x-ms-manifest"” enabled="true" />
mimeType="*/*" enabled="false" />

</dynamicTypes>
</httpCompression>

9. Run Command prompt as an Administrator and execute this command. This command will cache

every file instantly:

%windir%\system32\inetsrn\\appcmd.exe set config -section:system.webServer/serverRuntime -

frequentHitThreshold:1

10. ResetlIS.

Configuration

Select the Configuration component from the Perspective Service Manager menu and open the

Configuration tab. Click Browse to navigate to the Location of Server Configuration File.

Note: This option would be used when Perspective Services has been installed in a different location

than the default option.
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x Configuration Location of Server Configuration File
Y | Chinetpubienwwroot\Perspectived B\Pers pectiveServices\Perspective_ DEFALILT .config | | Browse... |
Database [] Encrypt Configuration?
)
."’5 Product Validation QA Advanced Security PCOAEIM25
Version: 4.6.1512

a Quick Find Indexing

User Defined Fields

@ Downloads

Client-Side Configuration

1.  Select the Configuration component from the Perspective Service Manager menu and open the

Client-Side Configuration tab.

2.  To update the configuration with a .zip file provided by the Technical Support, click Browse to
navigate to the Location of Updated Client-Side Reports. The field below will indicate the Version of

the client-side reports.
3. Click Update Reports to Server to complete the update.

Note: This option would be used if a newer version of client-side reports is available.

/" Coniuaaion " ClertSide Configastion | Noicaton | Atachments | servces | A€ Took |
~ Chent Reparts Configuaion

Download URL for Chentside Repoxts:
|hitp://<servemame> /petspectiveservices/chent/

Location of Updated Chentside Reports:
| Browse I

I™ Reports Exist on Server:

Chentside Reports Version:
|4.01128

Updaie Beports to Server
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SAML 2.0 Authentication for SSO

The following section provides instructions on configuring Perspective Service Manager to implement
SSO, however, prior to completing these steps, you must confirm your identity provider (IdP) supports
SAML 2.0 through service provider initiated SSO. SSO is supported for use with the Enterprise edition of

Perspective.

Your IdP will also need to provide you with instructions on adding and configuring new and existing

Perspective users directly through their service as IdP configurations will vary.

NOTE: If you're using AD FS to configure SAML, see the Set Up SSO with AD FS article on the Resolver

Support site for instructions after following the steps below.

1. Open Service Manager.

2. Click Configuration in the pane to the left if it's not already open.

3. Select the Configure Service Provider checkbox.

4, Enter your Perspective Services URL in the Perspective URL field, then click Validate.

Note: The URL you enter in this field must exactly match what has been entered into your IdP’s

configurations, including the case (upper-case or lower-case letters) and slash (/ or |) direction.

5. Enter the server certificate file name in personal exchange format (.pfx) in the Certificate File Name
field and enter a password in the Certificate Password field. For testing purposes, a sample .pfx file
has been included in the installation package with a file name of sp.pfx and a password of
password. This information is required so that the services (Perspective, Dispatch, Dashboard, etc.)

can securely communicate with the identity provider.

6. Save a copy of the certificate file to
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates. This file usually has a .PFX

extension and will also need to export the private keys.

Note: If you chose the default certificate file, the file was saved at this location during installation.
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& Perspective Service Manager I;‘i-

Seito i S Configuration ’/ Client-Side Configuration ’/ Motification ’/ Aftachments r Services ’/ AE Tools
AN ] Location of Server Corfiguration File
¥ Configuration 9
A
i C:Ninetpubwwwroot'\5 P\ Perspective Services'\Perspective_Default corfig
Fl: Database [] Enerypt Corfiguration?
r;:_) Product Validation QA Advanced Security PCOSEIM25

. Version: 5.2.0.51
R Quick Find Indexing

\User Defined Fields [[] Enable Client Side Application Insights

Corffigure Service Provider. This is required i you want to use SAML authentication.

! Downloads

Perspective URL {eg: https.//ACME.Mylncidents .com./Perspective Services ).
|hﬂps:,-’fexample.pme{H]'D.com!Perspecti\reSer\rices | | Walidate URL
Certificate File Name:

[sp ot |

Certificate Password:

| |

After completing the above steps, you'll need to select how you will input the identity provider’s details.
See the |dentity Provider Configuration section for information on uploading a metadata file or metadata

URL or see Manual Settings for instructions on inputting the data manually.

Identity Provider Configuration

The settings below allow you to import your IdP’s configurations directly into Service Manager via a

metadata file or metadata URL, which is obtained from your IdP.
1. In Service Manager, click Database in the pane to the left.
2. Double-click a database to edit it.

3. Click the Authentication Mode tab.

4. Select the SAML Authentication checkbox.

Note: If this option is unavailable, the service provider information has not been properly configured

in steps 3 and/or 4 in the section above.

5. Select how you want to input the identity provider information:
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Metadata file: This option will require that you obtain a metadata file from your IdP to
import the SSO configurations into Service Manager. When downloading a metadata file
from your IdP, the certificate is usually extracted and saved in your My Documents folder,
but it must be moved to
*PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates after it's been

downloaded.

To use this option, after downloading the file, enter the name of your IdP in the Description
field, which will appear to users with the phrase “Login with [IdP]” on the login screens, then

click Choose File to upload the metadata file.

Database Connection .

| Perspective | Analysis Expert Connection | Report Service | Authentication Mode I—

Perspective Authentication
SAML Authentication

® Metadata file () Metadata URL ) Manual settings

Description
| Example

Metadata URL: This option will require that you obtain a metadata URL that will import the
SSO configurations into Service Manager. After obtaining the URL, enter the name of your
IdP in the Description field, which will appear to users with the phrase “Login with [IdP]” on
the login screens. Enter a valid metadata URL from your IdP in the Metadata URL field, then
click Import. The URL will import the required configurations and should be similar to the

following:

httos.//adfs.example.com/FederationMetadata/2007-06/FederationMetadata.xm/

Note: The URL you enter in the Metadata URL field must exactly match what has been
entered into your IdP’s configurations, including the case (upper-case or lower-case letters)

and slash (/ or |) direction.
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Database Connection

| Perspective | Analysis Expert Connection | Report Service | Authertication Mode I_

Perspective Authentication
SAML Authertication

) Metadata file ® Metadata URL () Manual settings
Description

|Example

Metadata URL
|I'rl'tps:;";"adfs.example.u:u::m;-"FedemtinnMetadatafEﬂﬂ?—ﬂEfFedemt| | Impart

6. Click OK, then save your changes.

Manual Settings

If you're not importing metadata via a file or URL, you must configure your IdP’s settings manually.

Contact your IdP for instructions on obtaining the required information.

1. In Service Manager, click Database in the pane to the left.

2. Double-click a database to edit it.

3. Click the Authentication Mode tab.

4. Select the SAML Authentication checkbox.

Note: If this option is unavailable, the service provider information has not been properly

configured. See the Identity Provider Configuration section above for more information.

5. Select the Manual settings option.

6. Complete the following fields:

e Description: The name of your IdP, which will appear to users with the phrase “Login with

[[dP]” on the login screens.

¢ Name: The exact name of the IdP as provided by the IdP.
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e Partner Certificate File: Used to verify the assertions have come from the IdP. This file must

be saved to the *PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates folder.
¢ Single Logout URL: The URL from which the IdP accepts logout requests.
¢ Single Sign On Service: The URL from which the |dP accepts SSO requests.
e Name ID Format: The username format provided to the IdP.

¢ Single Sign On Service Binding: The binding used by the IdP to authenticate (usually HTTP
Redirect).

¢ Sign Authentication Request: Select this checkbox if the authentication request should be

signed.
e Sign Logout Request: Select this checkbox if the logout request should be signed.
e Sign Logout Responses: Select this checkbox if the logout response should be signed.
e Sign Assertion: Select this checkbox if the assertions should be signed.

e Encrypt Assertions: Select this checkbox if the assertions should be encrypted.
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| Perspective I Analysis Expert Connection | Report Sem'c:&| Authentication Mode I_
[«] Perspective Authentication
[w] SAML Authertication

() Metadata file () Metadata URL ® Manual settings
Description
|E:E|mp|e

MName
|h1'tp:f;"adfs.mple.ppm?ﬂﬂﬂ.cumfadfsfsewi:| [] Sign Authertication Request
PartnerCerificateFile [ ] Sign Logout Request

| 55EFIFFERABEXAMP LE28D283123634.c8r | [ Sign Logout Response
Single Logout Service Ud
|hﬁps:fﬁadfs.mple.pmeﬂDﬂ.cumfadfsfls |
Single Sign On Service Ud

[ ] Sign Assertion
[ ] Encrypt Assertion

|hﬁps:fﬁadfs.mple.pmeﬂDﬂ.cum!adfs;’ls | | Export Metadata
Mame |0 Format

|1|'lﬁnduws Domain Qualfied Name W |
Single Sign On Service Binding

|HTTP Redirect v

7. Click OK then save your changes.

Export Metadata

Once you’ve completed the configurations in the previous sections, your IdP will likely require

Perspective metadata in order to complete the SSO process. This information can be exported into a file

using the Export Metadata tool in Service Manager.

1. In Service Manager, click Database in the pane to the left.
2. Double-click a database to open it.

3. Click the Authentication Mode tab.

4. Select the Manual Settings option.
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5. Click Export Metadata.

6. Navigate to the *PerspectivelnstallationPath*\PerspectiveServices\SAML\Certificates folder, or an

alternate location you may have selected in the previous section.
7. Select a file name and location to export the metadata.

Note: It's recommended that you save the metadata file in
*PerspectivelnstallationPath*|PerspectiveServices|SAML|Metadata in the Perspective services

installation directory.

8. Click OK and the metadata file will be opened. Either upload a copy of this file to your IdP server or
save a copy in the *PerspectivelnstallationPath*\PerspectiveServices\SAML\Metadata folder if you

did not choose that location in step 6.

Perspective Configurations

Once the Service Manager and IdP configurations are complete, a Perspective administrator must enter
each user’s SSO username (as it's configured in the IdP’s settings) in the Corporate ID field by going to

Administration > Users > User Details.

Linked Person Role

i) Bernard, Milly R g X Chief Security Officer (Director]) =
First Mame Last Mame

Milly R Bernard

Perspective Logon D Corporate D

ets? millybernard

Change Password Approved By

[] Change Password On Login 'd‘ % X

See the Perspective Administrator’'s Guide for more information on entering this information in a user’s

profile.
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Integration Services

Integration Services should not require any additional configuration as all SAML authentication

information should be in the Perspective configuration file.

Service Clustering

Note: These configurations apply only to users installing Perspective with the Dispatch application. If

you're not installing Dispatch, skip this section.

The following are optional advanced configurations available to users employing the Dispatch
application. In order to complete these advanced configurations, the service cluster database must first
be restored on the database server (see Database Restore for more information). Additionally,

Perspective Services, including Integration Services, must be deployed on the web servers.

5. Navigate to the install directory of Integration Services. By default, the directory is located at

C:inetpub\wwwroot\Perspective5.3.1\IntegrationServices.
6. Open the web.config file.
7. Under appSettings, make changes as needed to the following settings for deployed web server:
° PerspectiveConfigFilePath: The physical path where Perspective Services is deployed.
° ServiceClusters: Enter true or false to enable or disable service clustering for Dispatch.

° ClusterServiceURL: The Integration Services URL (DispatchSystem service) of the node
within the cluster. This URL must be accessible by other nodes within the cluster in order

for service clustering to work.

4. If the ServiceClusters value is set to true, the database connection must be added to point to the

service clustering database. For example:

<add name="Perspective.IntegrationService.Properties.Settings.SystemDatabase"
connectionString="Data Source=<dbserver\dbinstance>;Initial Catalog=<dbname>;user

id=<user>;password=<password>;Application Name=Integration Services" />

Note: Avoid making changes to other cluster-related app settings, including:
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o  ClusterDatabasel ockTimeoutMilliseconds

o  ClusterRegistrationHeartbeatintervalMilliseconds
o ClusterRegistrationTimeoutMilliseconds

e InitialMasterCacheTimeOutMilliseconds

o PeerHeartbeatintervalMilliseconds

e PeerReceiveBufferSize

Any inconsistencies on these values between two nodes within the cluster may cause issues with

service clustering.

5. Save your changes in the web.config file then close.

Email Notifications

In Perspective, users may send email notifications containing incident or case details or report
attachments through Simple Mail Transfer Protocol (SMTP). Otherwise, email notifications may be sent
when new investigators are assigned to an investigation or when assignments are created, modified, or

completed.

To set up email notification options, select the Configuration component in the Perspective Service
Manager menu and open the Notification tab. Alternatively, the email function can be disabled by

selecting the Do not use mail options radio button.

Connect to an External SMTP Server

To use an SMTP server to send emails from Perspective, select the SMTP radio button and enter the

appropriate information for connecting to the SMTP server:
° Host: The domain name of the SMTP service.
° Port: The port the SMTP service will be listening on for connections.

° Username: A valid username to connect to the SMTP service.
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° Password: The appropriate password for the username.

° Enable SSL.: Select this option to encrypt the SMTP connection with Secure Socket Layer (SSL).

° Reply Address: By default, the SMTP service will include the address entered in this field when
sending emails, unless the Person who is currently logged in has an email address saved on their

record.

° Force all emails from this address: Selecting this checkbox will force all emails sent from
Perspective to use the Reply Address as a return email address, even if the currently logged in

Person has a primary email address saved on their record.

The email settings outlined above will be used as system defaults for every client.

Configuration ’/ Client-Side Configuration

0 Do not use mail options.
® SMTP

Host:

|mail ppm2000.com
Paort:

Usemame:

|p5\r

Password:

[] Enable SSL
Reply Address:
|no-reph.'1 @myincidents.com

[#] Forze all emails from this address.

Force all clierts to use these settings
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Uploading Attachments

Perspective allows users to attach any file type to any data record in the application. These files are
stored directly in the SQL database. Attachment size is the greatest factor in determining how much

space will be required in SQL.

To set up the maximum attachment size, select the Configuration component in the Perspective Service

Manager menu and open the Attachments tab.

Perspective can support files up to 2 GB in size (SQL'’s limit for binary data types); however, due to
restrictions you may have on the space available for your Perspective database or bandwidth in your
network, we do include an option to decrease this 2-GB limit to a size that can be better supported in

your environment.

° On SQL Standard or Enterprise, this value can be set between 1 MB and 2000 MB. The default is
set to 250 MB.

° On SQL Express, this value can be set between 1 MB and 50 MB. The defaultis 10 MB.

To change this value to an appropriate value for your organization, move the slider.

Specify mawimum zllowed altachment size for the chent

S

b ax attachment size: 250 MB

[Upper limét is 2GB for SOL Server 2005/2008 and SOMBE for SAL Express)

Save Changes Esat
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Integration Services URL

1. To enable event trigger in Integration Services, select the Configuration component from the

Perspective Service Manager menu and open the Services tab.
2. Enter the URL set up with the Integration Services in the Integration Services field.

3. Toenable trigger events on create and update, check the Enable Trigger Notification box. To enable

context-sensitive events, check the Allow Hot Key Events box.

/ Configuration I Client-Side Configuration ] Notification l Attachments /VServices ] AE Tools

Integration Services
|https://staging ppm2000.com/IntegrationServices3(|

[T Enable Trigger Notfication [T Allow Hot Key Events

PPPVPVVO OSSO IOOISISIOIe

) =

Save Changes Exit

Custom Search Integration

With Perspective’s Custom Search feature, you can integrate Perspective with Infoglide Identity
Resolution Engine™ (IRE) to search several data sources at once. Complete the following steps to enable
this integration. Note that you must first configure your Perspective database within the Identity

Resolution Engine before proceeding.

To set up the Custom Search feature, select the Configuration component from the Perspective Service
Manager menu and open the Services tab. Check the Enable Custom Search (with Infoglide) box and

enter the URL for the Infoglide Identity Resolution Engine in the field below.
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Note: To access the Custom Search feature, users must be granted the appropriate access rights in
Perspective. For details on administering Custom Search access for roles and users, see “Select general
role rights” and “Set general user rights” in the “Roles” and “Users” sections of the Perspective

Administrator’s Guide.

r,;'f1:*.5-1|igu-:|t'mn ru-n-ﬁd-caigmm ruwﬁmm I/-MM))/-SI\“ rA.ETmh |

Integration Senaces
frzos //Staging pem200 com.inbegraton Servces

™ Enabls Tagger Molfcation ™ Ao Mot Ky Everts
¥ Enable Custom Search fwith Infoghde)”
| it e, taxtriphenur] o]

A A A A A A A e

gave Changes gt

Mass Notifications

In Perspective, users can integrate their MIR3%" in Enterprise™ solution into Perspective in order to send

mass notifications about selected activities via Perspective DispatchLog.

To set up the Mass Notification feature, select the Configuration component from the Perspective Service
Manager menu and open the Services tab. Check the Enable Mass Notification (with MIR3) box and enter

the Mass Notification URL, Username and Password provided by MIR3 in the field below.
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Integration Services
[https://Staging ppm2000.com/Integration Services 30

I™ Enable Trigger Notification ™ Allow Hot Key Everts
I™ Enable Custom Search (with Infoglide)”

¥ Enable Mass Notiication fwith MIR3)
Mass Notification Ut
Jhitp://inwebservices mir3.com/services /v 1.2/mir3

Usemame: [GATest
Password: I- T

*Custom Search should not be enabled unless integrating an extemal seanch tool
from Infoglide to search several data sources at once.

Save Changes Exit

Analysis Expert Tools

If you experience difficulties with the correct Analysis Expert (AE) query display, this function must be

used to update the AE .dat file provided by Technical Support.

1.  Select the Configuration component from the Perspective Service Manager menu and open the AE

Tools tab.
2. Specify the SQL Server.

3. Select either the Windows or SQL Authentication. If you selected SQL Authentication, enter the

correct Username and Password.
4. Choose the Database you wish to update your queries on.

5.  Specify the correct path to the AE .dat file provided by Technical Support in the File Location field.
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6. Click Update.

Configuration y/CIient-Side Configuration y/NDtiﬁcatinn rﬂ.ﬁac:hments I/SBrvioes/ﬂETmls

— Database Connection
SQL Server: [4658GD1 R 7
i Windows Authentication
SQL Authentication
Usemame: I
Password: I
Databases: |Perspective j B
— AE File Location
File Location: I\‘mem |

pdate |

Save Changes Exit

Quick Find Indexing

With Perspective’s Quick Find tool, you can quickly search for text anywhere in the database, including

text within attachments. This works by scanning an index file generated on the server.

Quick Find Indexing supports the following file formats for attachments:

.doc, docx pdf Ixt
.docm rtf .wpd

log .sms .Wps
.msg text Xls, xIsx

1. To setup indexing on your database, select the Quick Find Indexing component in the Perspective

Service Manager menu.

2. To enable this feature, select Allow Quick Find.
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3.  Select an Index Directory to store the index files. The name of the index directory must end with
your organization’s business ID name (e.g. C:\Temp\[BusinessIDName]) and IIS must have access to

read this directory.

Note: If you're using Perspective On Premise and your organization’s business ID is Default, the

index entry will end in Default (e.g. C:\Temp|Default).

4.  Optional:You can expect the Index file to be approximately 1/3 of your database size. If storage on
the local drive would be problematic, you can force the index cache to use a separate directory by
checking Specify folder in alternate drive to store cache while indexing? and then selecting a

directory.

5.  Optional: If you would like certain common words to be ignored when indexing (e.g., a, the, an, at,
to, etc.), select Use noise word file? and specify the directory where your Noise.dat file exists.

Perspective does not provide a Noise.dat file.

6. Optional:If you would like hyphenated words to be indexed as two separate words, you can select

Treat hyphens as spaces.

7.  Optional:If you would like the index files to ignore any numeric text, you can select Do not index

numeric values.

8. Expand the nodes listed under Tables and select each table you want data to be indexed from
individually. Note that attachments are indexed separately from the main entities and can be found

at the bottom of the list.

9. Click Save.
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Database to Index

| Primary
{iy )
} Configuration [¥] Allow Quick Find

Index Directory
E Database cA[Your_Index_Path_Herel\[Your_Business_|ID_Herg]

#n [] Specify folder in altemate drive to store cache while indexing?
v' Product Validation Cache Drive/Directory

E Quick Find Indexing [+ Use noise word file?

Path where noise word file exists.

cwindows\system32

[] Treat hyphens as spaces.

[ lgnore numeric and date values

Entity/Column Selection

Select Al None
-] Activities

EE Activity kems

H-[] Activity Officer Responses

f|-[w| Activity Organization Requests
t|-[w| Activity Organization Responses
+-[wf| Activity Organizations

t-[wf| Activity Person

f-[w| Activity Person Clothing

0 L3 Ardiviiinr Domnnr Do

Powered by dtSearch®  www disearch.com

10. As data is added, deleted, or modified in the database, the index must be kept up-to-date. You can
perform full indexing or incremental indexing on a database by using the Perspective.Indexer.exe
program. To do this, open a Windows command prompt and navigate to the Perspective Service

Manager directory as follows:

cd “C:\Program Files\Resolver Inc\Perspective\5.3.1\ServiceManager”

11. To perform full indexing on the default database, enter the following command:
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Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath] \Perspective5.3.1\PerspectiveServices\Perspective

Default.config"

12. To perform full indexing on a specific database, add the /d switch to the command:

Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath] \Perspective5.3.1\PerspectiveServices\Perspective

Default.config" /d="database name”
13. To perform incremental indexing on the default database, add the /i switch to the command:

Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath] \Perspective5.3.1\PerspectiveServices\Perspective

Default.config" /i
14. To perform incremental indexing on a specific database, use the /d and /i switches:

Perspective.Indexer.exe
/c="C:\ [PerspectiveServicesPath] \Perspective5.3.1\PerspectiveServices\Perspective

Default.config" /d="database name” /i

15. Repeat steps 10-14 for every database you want to index.

16. There are other switches available when using Perspective.Indexer.exe. To view all of the switches

and their functions, enter the command Perspective.Indexer.exe ?

User Defined Fields

Although user defined fields (UDFs) can only be created by specialized users with access to both the
server machine and the Service Manager, they are maintained by Administrators in the same manner as
all other fields within Perspective. Visibility and access rights to a user defined field can be controlled
under System Privileges, Role Privileges or User Privileges. UDF labels can be modified and created for
other languages under Form Labels. Moreover, if the UDF is a lookup field, lookup values and workgroup

visibility for these values can be customized under Lookups.

You may add user defined fields to the Item, Person, Organization and Vehicle forms under the General

tab, as well as to numerous sections of the Incident and Case forms.

Note: The Case component is only available in the Premium edition of Perspective.
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1.

To set up user defined fields for Perspective, select the User Defined Fields banner at the bottom of

the Perspective Service Manager menu and open the General tab.

From the Form lookup list, select the data form in which you would like the new user defined field to

appear. Your options are as follows:

e Incidents

e Incident Items (Involved Items)

¢ Incident Organizations (Involved Organizations)
e Incident > Persons (Involved Persons)

e Incident > Vehicles (Involved Vehicles)

e ltems

e Organizations

e Persons

e Vehicles

e (Cases

e Activities

From the Section lookup list, select the specific section of the form that you would like the user
defined field to appear in. For all forms except Incidents and Cases, the only option available is the
General tab. For the Incidents form, you may choose the General, Investigations (Details) or Controls

tab. For the Cases form, you may choose either the General or Controls tab.

Click the Add button at the bottom of the window. An Add UDF dialog box will open.

Enter the new user defined field’'s name in the Field Name text box. Note that no special characters
or spaces may be used—letters only. Then, assign the field its default System English Label. The

System English label is what users will see on the Perspective form.

Choose the field type from the Data Type lookup list. The available field type options for UDFs are
Number (for whole numbers), Decimal Number (for numbers with up to two decimal places), Text,
Date, Yes/No (for a checkbox field) and Lookup List. If you selected Text as the data type, you may

also specify the maximum number of characters that can be entered in the field under Text Length.
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D
| Primary v | Primary Connection

Form Section
| Incidents v | |Genem|

General | Layout
Field Name

User Defined Fields
[=1"]

@Duwdoads

Please do not forget to restart the Perspective web Add UDF | | Edit UDF | | Delete
server after making changes.

Field Mame
Data Type
|Lookup List

e To edit the user defined field, click the arrow to the left of the Field Name to select the entire

row and click the Edit button. Make changes in the Edit UDF dialog box and click Apply.

m © Resolver Inc. Do not distribute. Page 51 of 73



Perspective Installation Guide Advanced Configurations

e To delete the user defined field, click the arrow to the left of the Field Name to select the entire
row and click the Delete button. A Delete UDF confirmation window will open warning you of
potential loss of data. If you choose to delete the selected UDF and click Yes, any data
previously tracked in the UDF will be erased as well. Instead, it's recommended that you hide or

lock the UDF within Perspective, if you no longer wish to use it to track data.

8.  Toview the user defined field with its default form location, select the Layout tab. The Top and Left
values indicate the number of pixels that the UDF will be located from the top left corner of the User

Defined Fields section of the form. The User Defined Fields section always appears at the bottom of

the form.
Form Section
|Inc:iu:|ent Personz j |General j

General | Layout

Default Layout Previous Layout | Save Layout {; I

e  Click and drag the UDF label to move the UDF to an alternative location on the form. The entire
scrollable window beneath the Layout tab is representative of the User Defined Fields section

of the form. Click Save Layout to save the chosen UDF location on the form.

e Atany time, you may click Default Layout to return the UDF to its original assigned position on

the form. To return the UDF to its last saved location, click Previous Layout.
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Troubleshooting Tips

Event Viewer

When an error occurs in your Perspective session, first check Event Viewer to see if it has been recorded

here.
1. Gointo Windows Event Viewer.
2. Click the Windows Logs folder.

3.  Click the Application sub-folder. Most errors that have occurred in Perspective will be logged here.

Perspective Server

@ Ensure Perspective Services is set up

1. Open IIS Manager, navigate to the Perspective Services Virtual Directory, and try to browse the

Service.asmx file.
2.  If the page that is displayed reads “Service”, the install was successful.
If you get an error code page:

a. Check the properties of the Perspective Services Directory and ensure it is running under

Microsoft .NET 4.0 on the ASP.NET tab.

b. Re-install Microsoft .NET 4.0 with ISS using the following command line:
C:IWINDOWSIMicrosoft. NET|Framework|v4.0.30319\aspnet_regiis.exe

% Connect to the database using ODBC
1. Select Control Panel > Administrative Tools > Data Sources (ODBC), and open the System DSN tab.
2. Click Add to create a data source, select SQL Server. Click Finish.

3.  Enter the name “Perspective” and select the name of your SQL Server.
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4. If your Perspective database is using SQL authentication, select the SQL server authentication

option and enter your SQL login credentials.

5.  Click Finish, and then click Test Data Source.

@ Test the application pool

An application pool is used to connect to the database server. To test if there is an issue with the Web
application pool, change the account to Network Services and see if it runs. If you are using Windows
Authentication for your Perspective database, change the application pool to the same one used for your

database. Reset the application pool, and then launch Perspective and try to login.

© Restart IIS

Right-click your Computer icon and select Manage. Expand the Services and Applications folder and
right-click Internet Information Services (IIS). Select All Tasks, then restart IS and click OK. Another way

to restart IS is to run the command line J/isreset from the Start menu.

Database Server

@ Ensure that the database login account has been assigned DBO access rights
1. In Enterprise Manager, select Security > Logins.

2. Double-click the domain user account that the Perspective server uses to connect to the database

(e.g., the test account “PerspectiveDBCon”).

3.  On the Database Access tab, select the Perspective database and ensure that dbo access is

assigned.

Reporting Services Server

For assistance and information on setting up SQL Reporting Services, view the deployment guide on

Microsoft's Web site: http://technet.microsoft.com/en-us/library/ms159868(SQL.90).aspx
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@ Check the version of the Microsoft .NET Framework

If NET Framework 3.5 is enabled on the machine, only client-side components of Reporting Services will
be installed. If necessary, remove the .NET Framework 3.5 before installing Reporting Services, and re-
install 3.5 afterwards using the following command line:

C:IWINDOWSIMicrosoft. NET\Frameworklv2.0.50727\aspnet_regiis.exe

@ Specify path for .bat file
1. Using the Windows Start menu’s Search function, search for the rs.exe file.

2. Place a copy of the rs.exe file in the Perspective Install > Reports Setup folder.

Perspective Client

@ Connect to the Web site
Open your Web browser and enter the following URL:

https.//<servername>/PerspectiveServices/Service.asmx

@ Ensure SQL login account is configured properly

The SQL login account (e.g., the test account “PerspectiveDBCon”) needs permissions.

@ Troubleshoot Windows authentication issues

Note: Windows authentication is available for Perspective only and must be enabled through the
Perspective_default.config file. If you wish to use single sign-on for all Perspective modules (Perspective,

Dispatch, Dashboard, and/or Web Portal) you must enable SAML authentication.

1.  Open the Perspective_default.config file. By default, this file is located at

C:linetoublwwwroot|Perspectivebs.3. 1|PerspectiveServices.
2. Confirm the value in the <WindowsAuthentication> tag is set to true.

Note: You cannot enable both Windows authentication and SSO in the Perspective_default config

file by changing the <SSOAuthentication> tag’s value to true.
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9.

<MSReportServicelser:

User Domain_MName;User_Login_Name;User_Password</MSReportServicelser>»
<Perspectivefuthentication>true</Perspectivefuthentication>
<WindowsAuthentications»false</WindowsAuthentications
<S50Authentications»false</S50Authentications
<PartnerIdentityProvider Name="" Description=

In 1IS, open the Default Web Site and your Perspective Services site.

Double-click the Authentication icon.

Ensure that:

° Windows Authentication is enabled.

° Anonymous Authentication is disabled.

Return to the previous screen and click Edit Permissions on the righ-side menu.

Open the Security tab, click Edit, and add appropriate Perspective Groups with View, Read, and

Execute permissions.

Reset IIS once you have completed the steps to ensure the changes take place.

Test logging in with a user who is set up for Windows Authentication in Perspective.

@ Troubleshoot application download issues

Using Command Prompt, you can remove cached data and uninstall Perspective from your machine.

Note: Deleting this cached data will remove all ClickOnce data from your computer.

Close all running applications. This will prevent the removal of the applications from the App Cache.
Right-click the Start/Windows icon in the bottom-right corner of your screen.

Click Run.

Type or paste rundll32 dfshim CleanOnlineAppCache in the the Run dialog.

Click OK to run the command.
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Note: Running this command will delete the contents of the 2.0 folder

(C:\Users|UserNamelAppDatalLocallApps|2.0 and will remove all ClickOnce applications from your

computer.
6. Browse to the Perspective Services URL.
7. Click the Launch Perspective button to re-download the entire Perspective application.
8. Click Run to launch the Perspective application.
9. Log onto Perspective (see the Perspective Administrator’s Guide or Perspective User’s Guide for

more information on logging on). If the problem persists, please contact Resolver Technical

Support at 1-877-776-2995 for assistance.
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Error Messages

Error Message Explanation

No Connection. Perspective Client error

Solution
° Launch the Perspective client from the Perspective server and attempt to logon.

° Make sure the user account is a member of the IIS_WPG group on the Perspective server.

Response is not well formed . XML. Perspective Client error

Solution

° May be due to a missing bracket or other formatting issue in the

Perspective_Default.config file.

° May also be a permissions issue. See your local Security Policy.

Connection to the service not found/SQL
Perspective Server error
Exception/Login failed for user.

Solution

Ensure the application pool account has access to the database. The account that the
Perspective server is using to connect to the database must be specified as the Application Pool

identity, and requires membership in the IIS_WPG.
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Contact Information

Technical Support

Toll Free: 1-877-776-2995

Phone: (780) 448-0616

Email: support@resolver.com
Website: https://support.resolver.com
Resolver

Toll Free: 1-888-776-9776

Phone: (780) 448-0616

Fax: (780) 448-0618

Email: information@resolver.com
Website: http://www.resolver.com

ﬂ © Resolver Inc. Do not distribute.
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Appendix A — Indexable Fields

Below is a complete list of the standard indexable fields that appear in Perspective and Service Manager.

Once indexed, these fields become searchable using the Quick Find tool in Perspective.

Note: Custom fields (also known as UDFs or user defined fields) can also be indexed so they become

searchable and appear in Service Manager.

Sub-Secton()

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Awctivities
Activities
Activities
Activities
Activities
Activities
Activities
Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Activities

Assignments

Assignments

Activity > ltems

Activity > ltems

Activity > ltems

Activity > ltems

Activity > ltems

Activity > ltems

Activity > ltems

Activity > ltems

Activity > ltems

Activity > Items

Activity > Officer Responses
Activity > Officer Responses
Activity > Officer Responses
Activity > Officer Responses

Activity > Organization Requests
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Access Level
Activity Number
Activity Status
Address 1
Address 2

Call Source

Code

Contact Number
Description
Disposition

Notes

Officer Status
Organization Status
Postal Code
Priority
Assignment Type
Message/Task
Category/Type
Disposition

Item Name

ltem Value

Linked Item
Make/Model
Notes
Organization Owned By
Person Owned By
Serial Number
Call Sign

Officer Name
Officer Response Notes
OfficerStatus

Comments
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Sub-Secionts

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Awctivities
Activities
Awctivities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities

Activities

Activity > Organization Requests
Activity > Organization Request
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Requests
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organization Responses
Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations

Activity > Organizations
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Contact First Name
Contact Last Name
Contact Middle Initial
Contact Person
Contact Phone
Involvement Type
Notified Type
Organization
Organization Name
Organization Number
Reference Number
Request Assigned To Person
Request Notes
Request Type
Tracking Number
Contact Last Name
Contact Middle Initial
Contact Person
Contact Phone
ContactFirstName
Involvement Type
Notified By Person
Notified Type
Organization
Organization Name
Organization Number
Organization Response Notes
Organization Type
OrganizationStatus
Reference Number
Responding Person
Comments

Contact First Name
Contact Last Name
Contact Middle Initial
Contact Person
Contact Phone
Involvement Type
Linked Organization
Notified By

Organization Name
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Sub-Secion(s

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Awctivities
Activities
Activities
Activities
Awctivities
Activities
Awctivities
Activities
Activities
Activities
Activities
Activities
Activities
Activities

Activities

Activity > Organizations
Activity > Organizations
Activity > Organizations
Activity > Organizations
Activity > Person > Clothing
Activity > Person > Clothing
Activity > Person > Clothing
Activity > Person Flags
Activity > Person > Injuries
Activity > Person > Injuries
Activity > Person > Injuries
Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Person

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles

Activity > Vehicles
Attachments

Attachments
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Organization Number
Organization Type
Organization Webpage URL
Reference Number
Clothing Type
Color

Description
Severity Level
Description

Injury Cause
Severity
Designation(s)
Employee Number
Eye Color

First Name

Flag Notes
Gender

Hair Color

Initial

Injured
Involvement Type
Last Name

Linked Person
Marital Status
Notes

Title

Color

Comments
Disposition

Driver Identified
Involvement Type
License Plate
Linked Vehicle
Make/Model

Plate Registered In
Style

Vehicle Value

VIN

Year

Attachment Title
Attachment Type
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Sub-Section()

Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Awctivities
Activities
Awctivities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities
Activities

Activities

Attachments
Attachments
Attachments

Call Category

Call Category

Call Category

Call Category

Call Category

Call Category

Involved Items

Involved Items

Involved Organizations
Involved Organizations
Involved Persons
Involved Vehicles
Involved Vehicles

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Geo Rollups

Link Activities

Link Activities

Link Activities

Link Activities

Link Activity To Incident
Link Activity To Incident
Link Activity To Incident
Link Activity To Incident
Link Activity To Incident
Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups

Site Rollups
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Description

File Extension

File Name

Call Category Name
Code

Level 1

Level 2

Level 3

Level 4

Item Category
ltem Name
Organization Number
Organization Type
Gender

Incident Number
Make/Model

City

Country

Geo Rollup Name
Geo Rollup Name
Level4

Rollup Level
State/Province
Link Type

Linked From Activity
Linked To Activity
Notes

Link Effective Date
Link Type

Linked From Activity
Linked To Incident
Notes

Address 1
Building

Location

Postal Code
Rollup Level

Site

Site Name

Site Notes

Site Rollup Name
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Sub-Secton()

Activities
Activities
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases

Cases

Site Rollups

Site Rollups

Case > Assignments

Case > Assignments

Case > Assignments

Investigations

Investigations

Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Case > Investigation > Evidence Log
Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status
CaselnvestigationInterviewHistory
CaselnvestigationInterviewHistory
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews
Case > Investigation > Interviews

Case > Investigation > Interviews
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Site Rollups

Threshold

Assignment Type
AttachmentFrom
Message/Task

Incident Number

Initiated By

Evidence Disposition
Evidence Log Status
Evidence Name

Evidence Type
Evidence/Property From
Evidence/Property Tag
Found/Seized Location
Item Description

Notes

Organization Owned By
Owner Name Person
Person In Possession
Secured/Storage Location
Seized By Person

Seized From Person
Comments

Evidence Disposition
Status

Storage Location
Evidence/Property Tag
Person In Possession
Status Changed By Person
ChangedByPersonDescription
Reason

Attached Digital Interview
Interview Conducted by
Interview From

Interview Type

Location of Interview
Plain Text

Subject of Interview
Subject's Involvement Type
Witness

Word File
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Sub-Sectont)

Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases
Cases

Cases

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Log

Case > Investigation > Summaries
Case > Investigation > Summaries
Case > Investigation > Summaries
Case > Investigation > Summaries
Case > Investigation > Summaries
CaselnvestigationSummaryHistory
CaselnvestigationSummaryHistory
Case > Investigators

Case > Investigators

Case > Investigators
CaseNarrativeHistory

Narratives

Case > Reviews

Case > Reviews

Cases

Cases

Cases

Cases

Cases

Cases

Cases

Cases

Case > Visibility

Case > Visibility

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Class Rollups

Evidence Log > Status

Evidence Log > Status
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Expense Type

Log Notes

Logs From

Logs From

Task Done By Person
Task Type

Author Person
Plain Text
Summary From
Summary Type
Word File
ChangedByPersonDescription
Reason
Comments
Investigator
Investigator Type
Reason

Word File
Comments
Review Type
Access Level

Case Category
Case Description
Case Name

Case Number
Disposition

Org Rollup

Status

All Workgroups
Owner Workgroup
Category

Class

Class Code

Class Name
Consequence
Rollup Level
Subcategory

Type

Class Rollup Name
Evidence Status

Person In Possession
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Sub-Secton()

Cases

Cases

Cases

Cases

Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents

Incidents

Investigation > Interviews
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews

Business Unit Rollups

Business Unit Rollups

Business Unit Rollups

Business Unit Rollups

Business Unit Rollups

Business Unit Rollups

Business Unit Rollups

Involved ltems

Involved Items

Involved ltems

Involved Organizations

Involved Organizations

Involved Organizations

Involved Organizations

Involved Persons

Involved Persons

Involved Persons

Involved Persons

Involved Vehicles

Involved Vehicles

Involved Vehicles

Narratives

Narratives

Narratives

Narratives

Incident > Assignments

Incident > Assignments

Incident > Assignments

Incident > Assignments

Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log

Incident > Investigation > Evidence Log
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Attached Digital Interview
Interview Conducted by
Interview Type

Plain Text

Business Unit Name
Business Unit Rollup Name
Level 1

Level 2

Level 3

Level 4

Rollup Level

Disposition

Incident Number

Loss Type

Incident Number
Involvement Type
Notified By
Organization Name

First Name

Incident Number
Involvement Type

Last Name

License Plate

Vehicle Involvement Type
Vehicle Year

Author

Narrative From

Narrative Type

Plain Text

Assigned By Person
Assigned To Person
Assignment Type
Message/Task
Disposition

Evidence Status
Evidence/Property Name
Evidence/Property Tag
Evidence/Property Type
Incident ID

Notes

Owner Name Organization
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Sub-Section()

Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents

Incidents

Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Incident > Investigation > Evidence Log
Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status

Evidence Log > Status
IncidentlnvestigationInterviewHistory
IncidentinvestigationInterviewHistory
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews
Investigation > Interviews

Incident > Investigation > Log

Incident > Investigation > Log

Incident > Investigation > Log

Incident > Investigation > Log

Incident > Investigation > Log

Incident > Investigation > Summaries
Incident > Investigation > Summaries
Incident > Investigation > Summaries
Incident > Investigation > Summaries
Incident > Investigation > Summaries
IncidentinvestigationSummaryHistory
IncidentinvestigationSummaryHistory
Incident > Investigators

Incident > Investigators

Incident > Investigators

Incident > Investigators

Incident > Items

Incident > Items

Incident > Items

Incident > Items

Incident > Items

Incident > Items

Incident > Items
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Owner Name Person
Person In Possession
Secured/Storage Location
Seized By Person

Seized From Person
Disposition
Evidence/Property Tag
Reason for Status Change
Status Changed By Person
Storage Location
ChangedByPersonDescription
Reason

Incident ID

Location of Interview
Subject of Interview
Subject's Involvement Type
Witness

Word File

Expense Type

Incident ID

Log Notes

Task Done By Person
Task Type

Word File

Author

Incident

Plain Text

Summary Type
ChangedByPersonDescription
Reason

Comments

Incident ID

Investigator

Investigator Type
Category/Type

Disposition

ltem Name

ltem Value

Linked ltem

Make/Model

Notes
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Sub-Secton()

Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents

Incidents

Incident > Items

Incident > Items

Incident > Items
IncidentNarrativeHistory
IncidentNarrativeHistory

Incident > Narratives

Incident > Narratives

Incident > Narratives

Incident > Narratives

Incident > Narratives

Incident > Organization > Requests
Incident > Organization > Requests
Incident > Organization > Requests
Incident > Organization > Requests
Incident > Organization > Responses
Incident > Organization > Responses
Incident > Organization > Responses
Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Organizations

Incident > Owner > History
Incident > Owner > History
Incident > Owner > History
Incident > Person > Clothing
Incident > Person > Clothing
Incident > Person > Clothing
Incident > Person > Flags

Incident > Person > Injuries
Incident > Person > Injuries

Incident > Person > Injuries
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Organization Owned By
Person Owned By
Serial Number
PersonDescription
Reason

Author
IncidentNumber
Narrative

Narrative Type

Plain Text

Request Assigned To Person
Notes

Tracking Number
Request Type
Notified By Person
Responding Person
Response Notes
Comments

Contact First Name
Contact Last Name
Contact Middle Initial
Contact Person
Contact Phone
Involvement Type
Linked Organization
Notified By
Organization Name
Organization Number
Organization Type
Organization Webpage URL
Reference Number
Comments

Owner Person
Owner Added Date
Clothing Type

Color

Description

Severity Level
Description

Injury Cause

Severity
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Sub-Section()

Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Persons
Incidents Incident > Reviews
Incidents Incident > Reviews
Incidents Incident > Reviews
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
Incidents Incidents
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Designation(s)
Employee Number
Eye Color

First Name

Flag Notes

Gender

Hair Color

Initial

Involvement Type
Last Name

Linked Person

Marital Status

Notes

Reviewed By Person
Title

Comments

Reviewed By Person
Review Type

Access Level
AttachmentCount
Corrective Action Summary
Disposition

Division Reported To
e-Incident Number
File Number

Flag Notes

Follow-up Required
Incident Duration
Incident Number
Investigation Comments
Investigation Duration
Police File Number
Policy Affected

Policy Name:

Primary Cause
Reported to Division
Reported to Police
Reported to Supervisor
Secondary Cause
Status

Summary
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Sub-Secton()

Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
Incidents
ltems

ltems

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Incident > Vehicles

Link > Incidents

Link > Incidents

Link > Incidents

Link > Incidents

Link Incident To Case

Link Incident To Case

Link Incident To Case

Link Incident To Case

Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Case > Detail
Link Incident To Incident > Detail
Link Incident To Incident > Detail
Link Incident To Incident > Detail
Link Incident To Incident > Detail
Link Incident To Incident > Detail
Link Incident To Incident > Detail
Link Incident To Incident > Detail
Site Rollups

Site Rollups

ltem > Class Rollups

Item > Class Rollups
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Color

Comments
Disposition

Driver Identified
Incident ID
Involvement Type
License Plate

Linked Vehicle
Make/Model

Plate Registered In
Style

Vehicle Driver

VIN

Year

Link Type

Linked From Incident
Linked To Incident
Notes

Case Number

Link Incident To Case
Link Type

Notes

Building

Category

Class

Incident Status

Link Incident To Case
Link Type

Site

Summary

Building

Category

Class

Incident Status

Link Incident Number
Site

Summary

Address 2

Section

Item Category

Item Class Name
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Sub-Secton()

ltems
[tems
ltems
ltems
ltems
ltems
ltems
ltems
ltems
ltems
ltems
[tems
ltems
[tems
ltems
[tems
ltems
[tems
ltems
[tems
[tems
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations

Organizations

ltem > Class Rollups

Iltem > Class Rollups

ltem > Class Rollups

Iltem > Class Rollups

Iltem > Class Rollups

Iltem Make Model Rollups

Iltem Make Model Rollups

ltem Make Model Rollups

Iltem Make Model Rollups

Iltem Make Model Rollups

Iltem Make Model Rollups

Iltem Make Model Rollups

ltems

ltems

ltems

ltems

ltems

ltems

ltems

ltems

ltems

Link Persons

Link Persons

Link Person To Organization
Link Person To Organization
Link Person To Organization
Link Person To Organization
Link Vehicles

Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Addresses
Organization > Email Addresses
Organization > Email Addresses
Organization > Email Addresses
Organization > Phone Numbers
Organization > Phone Numbers
Organization > Phone Numbers

Organizations
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Item Class Rollup Name
ltem Type

Level3

Level4

Rollup Level

ltem Make

ltem Make Model Name
Item Make Model Rollup Name
ltem Model

Level3

Level4

Rollup Level

Access Level

Iltem Class Rollup

Item Make Model Rollup
ltem Name

Notes

Owner Identified
Owner Name Organization
Owner Name Person
Serial Number

Linked To Person

Link Type

Link Type

Notes

Organization

Person

Notes

Address 1

Address 2

Geographic Rollup
Organization ID

Type

Zip/Postal Code

Email Address
Organization ID

Type

Organization ID

Phone Number

Type

Access Level
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Sub-Secton()

Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Organizations
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons

Persons

Organizations
Organizations
Organizations
Organizations
Organizations
Organizational Rollups
Organizational Rollups
Organizational Rollups
Organizational Rollups
Organizational Rollups
Link Organizations

Link Organizations

Link Organizations

Link Vehicles

Link Vehicles

Link Vehicles

Person > Addresses
Person > Addresses
Person > Addresses
Person > Addresses
Person > Addresses
Person > Email Addresses
Person > Email Addresses
Unique Features

Unique Features

Unique Features

Person > Flag List
Person > Flag List
Person > Flags
Identification
Identification
Identification
Identification

Person > Phone Number
Person > Phone Number
Persons

Persons

Persons

Persons

Persons

Persons
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Notes

Organization Name
Organization Number
Organization Type
Organization Webpage URL
Org Level 1

Org Level 2

Org Level 3

Org Level 4

Org Rollup Name

Link Type

Linked From Organization
Linked To Organization
Link Type

Linked From Vehicle
Linked To Vehicle
Address 1

Address 2

Address Type
Geographic Rollup
Zip/Postal Code

Email Address

Email Type
Description

Feature Type

Location

Flag Description
Letter Code

Severity

Comments
Identification Number
Identification Type
Issued By

Phone Number
Phone Type

Access Level
Additional Information
Designation
Employee

Employee Number

Eye Color
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Appendix A — Indexable Fields

Sub-Section()

Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Persons
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles
Vehicles

Vehicles

Persons

Persons

Persons

Persons

Persons

Persons

Persons

Person > Trespasses

Person > Trespasses

Link > Organizations

Link Organization To Vehicle
Link Organization To Vehicle
Link Organization To Vehicle
Link Organization To Vehicle
Link Persons

Link Persons

Link Person To Vehicle

Link Person To Vehicle

Link Person To Vehicle

Link Person To Vehicle
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicle > Make Model Rollups
Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles

Vehicles
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First Name

Flag Notes

Gender

Hair Color

Initial

Last Name

Title

Comments

Site Rollup

Notes

Link Type

Notes

Organization
Vehicle

Linked From Person
Notes

Link Type

Notes

Person

Vehicle

Make

Model

Rollup Level

Rollup Name
Vehicle Make Model Name
Vehicle Make Model Rollups
Access Level
Branch

Color

Comments
Company Vehicle
Division
Geographic Rollup
License Plate

Photo

Style

Vehicle Make/Model
Vehicle Value

VIN

Year
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